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Exercises Accompanying Session 
State-space models and the Kalman filter  

Pawel Zabczyk 

 

Problem 1 (Worked through below) 

Consider the following time-varying regression for quarterly Brent Crude oil prices 𝐵𝑅𝑡 

𝐵𝑅𝑡 = 𝛽1𝑡 + 𝛽2𝑡𝐵𝑅𝑡−1 + 𝑒𝑡 

(
𝛽1𝑡

𝛽2𝑡
) = (

0

0
) + (

1  0

0  1
) (

𝛽1𝑡−1

𝛽2𝑡−1
) + (

𝑣1𝑡

𝑣2𝑡
) 

where: 

 VAR(𝜀𝑡) = 0.6 
 

 VAR(𝑣1𝑡
𝑣2𝑡

) = (0.001           0
0          0.006

) 

A. Use Eviews to find the filtered and smoothed estimates of the state vector 

B. Use Eviews and attempt to estimate R and Q via maximum likelihood 

C. Repeat the above using Matlab 

NOTE: Set 𝛽0\0 = (0, 0)′ and 𝑃0\0 = (100    0
0    100). Data is provided in spreadsheet Data.xls. 

 

 

Solution to Problem 1 

First convince yourself that this is a standard state space model. Note that, using the notation from the 

slides, we have 

 𝑦𝑡 = 𝐵𝑅𝑡  𝑥𝑡 = (1, 𝐵𝑅𝑡−1)  𝛽𝑡 = (𝛽1𝑡, 𝛽2𝑡)′ 

 𝜇𝑡 = (0
0)  F = (1  0

0  1) 
 𝑅 = 0.6,  

 𝑄 = (0.001          0
0          0.006) 

Now start Eviews. We will begin by creating a new workfile. To do that go to: 

File → New → Workfile and press ENTER 
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Since we are dealing with time 
series data, you can leave 
Workfile structure type (in the top 
left corner) set to  
Dated – regular frequency 
 
In the ’Date specification’ (in the 
top right corner) set  
Frequency to Quarterly 

 
For the start date type 1987Q3 
and let the End date equal to 
2015Q4.  

 
In the Names (optional) panel (at 
the bottom) in the WF: window, 
choose a name for your Workfile. 
We shall call ours STATESPACE. 
 

 
 
 
Click the OK button to create 
your workfile. You should see a 
window appear that looks 
something like this → 
 

 
 
 
 
 

 
 

 

The next thing we will need to do is to load in our data from the Data.xls file. To do that, depending on 

your Eviews version, click on: 

Proc (the one in the workfile window!) → Import → Read Text, Lotus, Excel → Data.xls → ENTER 

or 

Proc (as above) → Import → Read → (choose files of type Excel *.xls) → Data.xls → ENTER 
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The following window should open: 

Our data are in 
columns, so we don’t 
change Data order 
 
However because we 
have descriptions, our 
upper-left data cell 
should be changed to 
B3 
 
Finally, we can give our 
imported series 
names: BR (for the 
Brent price) and BR1 
(for the lagged Br) 
 
Once your screen looks 
like the one on the 
right, click OK to 
confirm. 

 

We can now specify our initial values of 𝛽0\0 = (0, 0)′ and 𝑃0\0 = (100    0
0    100).  

To set 𝛽0\0 do the following (see also description on the following page): 

 

 

Step 1 Step 2 
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I.e. go to: Object (in your workfile window) → New Object → Matrix-Vector-Coefficient → Type in Name 

‘beta00’ → click OK 

Then select Vector and in Dimensions  choose 2 rows and 1 column. Click on OK.  

The vector is full of zeros (by default) as necessary, so no further work is needed. 

 

To set 𝑃0\0 do the following (see also images below): 

Go to: Object (in your workfile window) → New Object → Matrix-Vector-Coefficient → Type in Name 

‘p00’ → click OK 

Then select Symmetric Matrix and in Dimensions  choose 2 rows and 2 columns. Click on OK. 

 

 

 

Step 1 Step 2 
 

NOTE:  It is important that you choose Symmetric Matrix rather than Matrix here, as the other would 

subsequently generate errors.  
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You will then see the following 
window open → 
 
We need to put 100 on the 
diagonal of the matrix. 
 
To do that, click on the Edit +/- 
button and then simply enter 100 
and 100 to end up with 
something like: 
 

 

 
 
Close the window once done. 

 

 
 
 
 
 
We now have all the variables defined to allow us 
to solve point A of our exercise. To do that we 
need to declare our state space model. 
 
 

 
 

To declare a state space model go to: Object (in the workfile window) → New Object → SSpace → Set 

name for object as ‘ss01’ → and click on OK 
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This should open the following 
window → 
 
This window is where we enter 
our model specification, sticking 
to some Eviews conventions: 
 
First we need to specify where 
our initial values for the state 
and variance are located. This is 
done with the @mprior and 
@vprior commands respectively.  
 
Accordingly we type in: 
@mprior beta00 
@vprior p00 
as these are the variables 
containing our variances. 

 
 

We then need to enter our 
observation / signal equation 
using the @signal command. 
This can be done as follows: 
 
@signal BR = beta1 + 
beta2*BR1 + [var=0.6] 
 
Once this is done, all that 
remains is to enter the 
dynamics of the state 
variables (using the @state 
command): 
 
@state beta1 = beta1(-1) + 
[var=0.001] 
@state beta2 = beta2(-1) + 
[var = 0.006] 
 
In the end the window 
should look something like →  
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We can now run the Kalman filter. Somewhat 
confusingly, even though we are not 
estimating anything here, we run the Kalman 
filter by going to 
 
Proc (in the state space object window) → 
Estimate 
 
This opens the following window. Since we 
are not actually estimating anything at this 
stage, none of the options matter much and 
we can simply click on OK. 

 
 

 

This completes part A of the exercise. At this stage it is probably a good idea to play around with the 

estimation output etc.  

 

We can now proceed to part B, i.e. Maximum Likelihood estimation. In principle, we could define a 

new workfile, import data etc., but since we have already done that, we can simply stay in the workfile 

we are currently using and define a new state space object. As before, to define a state space object: 

Go to Object (in the workfile window) → New Object → SSpace → Set name for object as ‘ss02’ → and 

click on OK 

What we will be estimating is the variance-covariance matrices 𝑅 = 0.6 and 𝑄 = (0.001          0
0          0.006) that 

we have previously calibrated. We thus need to start by telling Eviews what parameters we would like 

to estimate. In our case, since we assume that the Q matrix is diagonal, three parameters will suffice. 

We will denote them by c(1), c(2) and c(3).  

Of course, variances are non-negative, accordingly, to ensure that we end up with a positive estimate, 

we can specify the variance as [var = exp(c(1))]. Here, irrespective of whether c(1) is positive or 

negative – the variance term will be non-negative.  
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The final thing we will need to specify is a starting guess for the ML optimizer for the parameters we’ll 

be estimating. We set will set c(1) = c(2) = c(3) = -2 implying that our initial guess for the variance is 

exp(-2) = 0.1353. 

 Bringing all this together, to 
specify the unknown 
parameters we use the 
param command, followed 
by the name of the 
parameter and the starting 
value, i.e. we would type: 
 

param c(1) -2 c(2) -2 c(3) -2 
 

The syntax for the rest of the 
model is pretty much exactly 
as was, except the variances 
are now functions of the 
unobserved parameters.  
 

Specifically, the model in a 
form ready for estimation, 
should look something like: 

 

To run estimation, we would again go to proc (in the Sspace window) → estimate → and click on ok 

The results should look 
something like the box here, 
with the final ML coefficients 
for C(1), C(2) and C(3) given 
in the Coefficient column in 
the top panel and also saved 
in the C vector. 
 
Looking at the log-likelihood, 
we see that it is now -
357.3047 – i.e. above our 
previous value of  
-425.7689, i.e. 
(unsurprisingly) the 
estimated specification is 
“more likely” than the 
calibrated one.  
  
 

This completes part B of the exercise. Again, at this stage it is probably a good idea to play around / 

familiarize yourself with the estimation output etc.   
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To run part 3 of the exercise, we will need to start Matlab. In Matlab the first part of the exercise is 

implemented by the file kalmansmoother.m which we will now go through, step by step. The file is 

missing some parts, indicated by [XXX] which we will fill in together. 

Step 1: Disclaimer and workspace-management 
%---------------------------------------------------------------------------% 
%This script implements the Kalman filter and smoother in Matlab            % 
%(c) CCBS Bank of England                                                   % 
%---------------------------------------------------------------------------% 

  
clear all;                          %Clear workspace 
addpath('functions');               %Add auxiliary functions to workspace 
 

Step 2: Loading data 
%% ============================Load Data=================================== 

  
Y = xlsread('Data.xls','DATA','B3:B116'); %This loads Brent Crude price data 
X = xlsread('Data.xls','DATA','C3:C116'); %This loads Brent Crude lagged price data 

  
T = rows(X);               %The number of observations we use 
X = [XXX];                 %This will be the matrix of 'regressors' 

 
Step 3: Initialize all relevant variables 
 

%% ===============Initialise State and Covariance Matrix=================== 
b00 =[XXX];                          %b00 will hold the initial state 
p00 =[XXX];                          %p00 will hold the initial covariance 

  
%% =============Initialize Matrices for State Space Representation========= 

  
MU =[XXX]; % MU the constant in the transition equation is zero 
F  =[XXX]; % F  the matrix multiplying the lagged state in the 
           %    transition equation is a 2x2 identity matrix 

  
Q = [XXX]; % Q contains variances of transition equation shocks 
R = [XXX]; % R contains variances of observation equation shocks 

 
Step 4: The main Kalman filter routine 
%% ===========================The Kalman Filter============================ 
beta_tt  =zeros(T,2);%This matrix will hold filtered states (beta_t\t) 
ptt=zeros(T,2,2);    %This matrix will hold filtered state variances (p_t\t) 

  
%NOTATION: 1 will denote current variables (i.e. those dated t) 
%          0 will denote lagged variables  (i.e. those dated t-1) 
%Accordingly: beta11 will be denote the current estimate of beta while 
%             p11 will denote the current estimate of beta's variance 

  
%To initialize, we simply set beta11 and p11 to b00 and p00 respectively 
beta11  =b00;  
p11     =p00;  

  
% We are ready to start the main Kalman Filter loop 
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for i=1:T       %i will number the current period 
    x=X(i,:);   %Start by loading predetermined variables in X 

     
    %PREDICTION equations (refer also to slide #10 Kalman Filter Overview) 
        beta10  = MU + beta11*F'; %Use transition eq. to get current beta 
        p10     = F*p11*F'+Q;     %as well as p 

     
        eta     = Y(i,:) -(x*(beta10)')';%Use current beta to PREDICT y 
                                         %And compute PREDICTION error eta 
        feta =(x*p10*x')+R;              %and its variance feta 

  
     %UPDATING equations  
        K=(p10*x')*inv(feta);     %Compute Kalman gain K 
        beta11=(beta10'+K*eta')'; %Use Kalman gain to update beta 
        p11=p10-K*(x*p10);        %Use Kalman gain to update p 

     
    ptt(i,:,:)=p11;               %Store updated value of p and beta 
    beta_tt(i,:)=beta11;          %In vectors ptt and beta_tt  
end             %Iterate until no more data 

 
Step 5: The main Kalman smoother routine 
%% =======================The Kalman Smoother============================== 

  
beta_TT=zeros(T,2); %This matrix will hold filtered states (beta_t\T) 
pTT=zeros(T,2,2);   %This matrix will hold filtered state variances (p_t\T) 

  
%NOTE: Matlab is case sensitive - i.e. this differs from beta_tt and p_tt 

  
i=T;   %Start from final period; initialize smoother by loading filtered  
beta_TT(i,:)=beta_tt(i,:);     %estimates of beta and  
pTT(i,:,:)=ptt(i,:,:);         %p - the covariance matrix of beta 
for i=T-1:-1:1  % Go backwards as in slide #18 on Kalman smoothing 

     
    %Extra step, relative to slides is that we did not (for efficiency) 
    %reasons store p_t+1\t (called here pnext) so we need to start by 
    %computing it! Do do so, we shall use the exact same formula as in  
    %the prediction stage of the Kalman filter: F*P t-1\t-1*F' +Q 
    pnext=F*squeeze(ptt(i,:,:))*F'+Q; 
    ipnext=pinv(pnext); 

     
    %pcurrent will be p_t\t while pTTcurrent will be p_t+1\T 
    pcurrent=squeeze(ptt(i,:,:)); pTTcurrent=squeeze(pTT(i+1,:,:)); 

     
    %We can now directly apply Kalman smoothing formulae 
    beta12=beta_tt(i,:)+(pcurrent*F'*ipnext*(beta_TT(i+1,:)-beta_tt(i,:)*F'-MU)')'; 
    p12=pcurrent+pcurrent*F'*ipnext*(pTTcurrent-pnext)*ipnext'*F*pcurrent'; 

     
    beta_TT(i,:)=beta12;    %Store filtered value of p and beta 
    pTT(i,:,:)=p12;         %In vectors pTT and beta_TT 
end %Iterate until back in first period 
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Step 6: Auxiliary stuff 
%% ==================Auxiliary computations and plotting ================== 

  
%For ease of plotting save smoothed standard errors of states 
se=zeros(T,2); 
for i=1:T 
    temp=squeeze(pTT(i,:,:)); 
    se(i,1:2)=sqrt(diag(temp))'; 
end 

  
%Plot filtered and smoothed estimates of the state 
h1=figure(1); 
subplot(2,1,1); 
plot([beta_tt(:,1) beta_TT(:,1)]); 
title('constant') 
legend('filtered','smoothed') 
subplot(2,1,2); 
plot([beta_tt(:,2) beta_TT(:,2)]); 
title('AR(1) coefficient') 
legend('filtered','smoothed') 

 
This completes the equivalent of part A of the first exercise in Matlab.  

We will proceed to estimate matrices Q and R as done in part B of the exercise. This is done in the file 

estimate.m which we will now go through step by step. The file starts with a disclaimer and loading in 

data, before the key part which is this: 

Step 1: Call Chris Sims’ csminwel routine and apply it to file ‘kalmanfilterlik.m’ 
%% ==Define starting values for all estimated parameters (for ML to start)= 
theta0=[XXX]; 

  
%% ===================Call Chris Sims' optimization routines ============== 
[FF,AA,gh,hess,itct,fcount,retcodeh] = ... 
    csminwel('kalmanfilterlik',theta0,eye(3)*.1,[],1e-15,1000,Y,X); 

  
%Note: FF is the value of the likelihood at the optimal parameters AA 
%      The remaining variables are derivatives and diagnostics returned by 
%      csminwel 

 
Accordingly, to understand what estimate.m does we need to understand what kalmanfilterlik.m 

returns. A brief inspection shows that kalmanfilterlik.m is exactly the same code as in Step 4 above 

with one single exception, which we now look at: 

Step 2: A closer look at kalmanfilterlik.m 
%We also need to initialize likelihood 
lik=0; 

  
% We are ready to start the main Kalman Filter loop 

  
for i=1:T       %i will number the current period 
    x=X(i,:);   %Start by loading predetermined variables in X 
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    %PREDICTION equations (refer also to slide #10 Kalman Filter Overview) 
        beta10  = MU + beta11*F'; %Use transition eq. to get current beta 
        p10     = F*p11*F'+Q;     %as well as p 

     
        eta     = Y(i,:) -(x*(beta10)')';%Use current beta to PREDICT y 
                                         %And compute PREDICTION error eta 
        feta =(x*p10*x')+R;              %and its variance feta 

  
     %UPDATING equations  
        K=(p10*x')*inv(feta);     %Compute Kalman gain K 
        beta11=(beta10'+K*eta')'; %Use Kalman gain to update beta 
        p11=p10-K*(x*p10);        %Use Kalman gain to update p 

         
    ptt(i,:,:)=p11;               %Store updated value of p and beta 
    beta_tt(i,:)=beta11;          %In vectors ptt and beta_tt  

  
     %The only extra step: updating the likelihood 
        li = -0.5*N*log(2*pi) + 0.5*log(det(inv(feta))) - 0.5*eta'*inv(feta)*eta; 
        if ~isBR(li) && ~isnan(li)  
            lik=lik+li; 
        else 
            lik=lik-10; 
        end 
end             %Iterate until no more data 

  
lik=-1*lik; %Return minus likelihood so that min -f = max f 
So, basically, the likelihood is updated at each step of the Kalman filter computation based on the 

variance of the prediction error. To maximize likelihood we are minimizing minus the likelihood. 

Once we find the value 
of parameters  that 
maximize the likelihood 
we can then run the 
Kalman filter and 
smoother using those 
parameter values and 
report the t-ratios of 
the errors and plot the 
smoothed statistics. 
 
 
This completes the 
exercise. 
 

 
 


